
 

DevSecOps with Dr. Chuck Easttom 

Labs 

 

Contents 
General Instructions ........................................................................................................................ 4 

General Labs (regardless of code repository) ................................................................................. 5 

Lab 1 – Jenkins Initial Setup (Recipe Lab) ................................................................................. 5 

Step 1: Navigate to URL ......................................................................................................... 5 

Step 2: Download the Windows MSI...................................................................................... 6 

Step 3:Install Jenkins .............................................................................................................. 7 

Step 4:Navigate to http://localhost:8080/................................................................................ 7 

Step 5: Install Plugins ............................................................................................................. 8 

Lab 2 – Create a Pipeline in Jenkins(Recipe Lab) .................................................................... 10 

Step 1 Create a New Item ..................................................................................................... 10 

Step 2: Type in Script .............................................................................................................11 

Step 3: Build Now ................................................................................................................. 12 

Step 4: View Stages .............................................................................................................. 12 

Lab 3 - Get WebGoat ................................................................................................................ 13 

Step 1: Navigate to URL ....................................................................................................... 13 



Lab 4 - Eclipse  Initial Setup (Recipe Lab)............................................................................... 16 

Step 1: Navigate to ............................................................................................................... 16 

Step 2:Download Eclipse ...................................................................................................... 16 

Step 3: Unzip and Install ....................................................................................................... 17 

Lab 5 –Visual Studio Community Initial Setup (Recipe Lab) .................................................. 19 

Step 1: Navigate to URL and download ............................................................................... 19 

Step 2:Install ......................................................................................................................... 20 

Step 3:Launch ....................................................................................................................... 21 

Lab 6 VS Code Initial Setup ..................................................................................................... 22 

Lab7– Jira Initial Setup (Recipe Lab) ....................................................................................... 22 

Step 1: Navigate to URL ....................................................................................................... 22 

Lab 8: Synch Jenkins with Jira (Recipe Lab) ........................................................................... 22 

Step 1: Navigate to URL and login ....................................................................................... 22 

Step 2: Go to New Apps........................................................................................................ 22 

Step 3: Navigate to Jenkins ................................................................................................... 24 

Step 4: Install Jira Integration ............................................................................................... 25 

Step 5: View Jira ................................................................................................................... 25 

Lab 9 Building an App in Jenkins (experiment lab) ................................................................. 28 

Lab 10: Integrate Visual Studio Code with Jira (Recipe Lab) .................................................. 29 

Step 1: Get Jira in VS Code .................................................................................................. 29 

Lab 11: Test WebGoat in VS Code ........................................................................................... 30 

Step 1: Open Web Goat ......................................................................................................... 30 

Step 2: Run Basic Tests ......................................................................................................... 31 

Lab 12: OWASP ZAP ............................................................................................................... 32 

Lab 13: Testing in Visual Studio ............................................................................................... 32 

Bit Bucket Labs............................................................................................................................. 32 

Lab 14 – BitBucket Initial Setup (Recipe Lab) ........................................................................ 32 

Step 1: Navigate to URL ...................................................................................................... 33 

Step 2: Get the Free version ................................................................................................. 33 

Step 3:Create an account ....................................................................................................... 33 

Step 4: Create a workspace ................................................................................................... 34 



Step 5:Create a repository ..................................................................................................... 35 

Lab 15: Synch Jenkins and BitBucket  (Recipe Lab) ............................................................... 37 

Step 1: Go to Plugins ............................................................................................................ 37 

Step 2: Visit Jenkins - System ............................................................................................... 37 

Lab 16 – Setup Project in Bit Bucket and integrate with Eclipse (Recipe Lab) ....................... 38 

Step 1: Navigate to URL ...................................................................................................... 38 

Step 2: Create a Repository................................................................................................... 38 

Step 3: View Project .............................................................................................................. 40 

Step 4: Open Eclipse ............................................................................................................. 41 

Step 5: Share Project ............................................................................................................. 43 

Step 6: Configure Git repository ........................................................................................... 44 

Step 7: Commit ..................................................................................................................... 45 

Step 8: Push........................................................................................................................... 48 

Step 9: View code in BitBucket ............................................................................................ 50 

Step 10: Return to Eclipse..................................................................................................... 54 

Lab 17: Integrate Bitbucket with VS Code ............................................................................... 60 

Step 1: Get Bitbucket in VS Code ........................................................................................ 60 

Step 2: Connect to Bitbucket ................................................................................................ 61 

GitHub Labs .................................................................................................................................. 62 

Lab 18 – GitHub Initial Setup (Recipe Lab) ............................................................................. 62 

Step 1:Navigate to URL ........................................................................................................ 62 

Lab 19: Integrate Visual Studio Code with Github (Recipe Lab) ............................................. 63 

Step 1 Setup Project .............................................................................................................. 63 

Step 2: Install the GitHub extensions.................................................................................... 63 

Step 3 Connect to Github ...................................................................................................... 65 

Lab 20: Viewing Activities in GitHub ...................................................................................... 69 

Step 1: Login into a GitHub repository................................................................................. 69 

Step 2: Check Status ............................................................................................................. 69 

Step 3: Setup Security ........................................................................................................... 70 

Lab 21: GitHub Collaboration .................................................................................................. 73 

Step 1: Invite Collaborator .................................................................................................... 73 



Step 2: Accept the invitation ................................................................................................. 75 

GitLab Labs .................................................................................................................................. 76 

Lab 22 GitLab New project ...................................................................................................... 76 

Step 1: Start New GitLab project .......................................................................................... 76 

Step 2: Use Sample Template ............................................................................................... 77 

Step 3: Review results ........................................................................................................... 78 

Lab 23: Create a Pipeline in GitLab ......................................................................................... 79 

Step 1: Setup YAML file ....................................................................................................... 79 

Step 2: Setup Pipeline in YAML ........................................................................................... 80 

Step 3: See your pipeline running ......................................................................................... 81 

Lab 24: GitLab Secure Scanning .............................................................................................. 82 

Lab 25 Experiment With GitLab ............................................................................................... 82 

Step 1 Setup Project in GitLab.............................................................................................. 82 

Step 2: Setup CI/CD.............................................................................................................. 83 

Step 3: Security Configuration.............................................................................................. 84 

Online Labs (No VM needed) ....................................................................................................... 85 

Lab 26: HackMe Pipeline Lab .................................................................................................. 85 

Lab 27: Hackme DevSecOps Setup  (Recipe Lab) ................................................................... 86 

Lab 28: Hackme DevSecOps Setup  (Recipe Lab) ................................................................... 87 

Lab 29: Git(Recipe Lab) ........................................................................................................... 87 

Lab 30: Docker (Recipe Lab) ................................................................................................... 89 

Lab 31: Kubernetes (Recipe Lab) ............................................................................................. 90 

Lab 32: Another Kubernetes Lab (recipe/experiment) ............................................................. 91 

Lab 33: HackMe  Kubernetes ................................................................................................... 93 

Lab 34: HackMe Intro to IaC .................................................................................................... 93 

Lab 35:Terraform Online Lab (recipe/experiment) .................................................................. 94 

Lab 36: Online OWAS ZAP ..................................................................................................... 95 

 

 

General Instructions 



Most of the labs are what I call ‘recipe labs’.  This means you simply follow the specific steps in 

order and it will work as shown. There is nothing you need to figure out.  Then there are some 

labs that have most of it spelled out for you, with something you have to figure out. These are 

meant to help you reach the next level in knowledge. 

 

NOTE: SHUT DOWN everything you can. This will maximize your performance. If it is not 

related to this class, turn it off. 

General Labs (regardless of code repository) 

 

Lab 1 – Jenkins Initial Setup (Recipe Lab) 

Jenkins should already be installed on the VM.  There should be a password file on that VM. It 

will be a text file on the desktop. However, if you do need to download Jenkins, the steps are 

given here 

Estimated time 20 minutes 

Step 1: Navigate to URL 

https://www.jenkins.io/ 

The click download and select 

https://www.jenkins.io/


 

Step 2: Download the Windows MSI 

For a Windows machine you can use .war or Windows, I used the Windows.msi 



 

Step 3:Install Jenkins 

Use default settings 

Step 4:Navigate to http://localhost:8080/ 

Then navigate to  

http://localhost:8080/ you should see 

http://localhost:8080/login?from=%2F
http://localhost:8080/login?from=%2F


 

After you enter that password you should see the following screen: 

 

Step 5: Install Plugins 

Select ‘Select plugins to install’ leave all the default but add Dashboard view, MSBuild, Junit, 

bitbucket, and CVS (git should already be checked) 

At the end of installing those plugins you will be asked to create admin username and password 



 

For this lab make it Adminperson  and LetMeIn 

 

Now you should see the following 



 

 

You are ready to start using Jenkins!! 

 

 

Lab 2 – Create a Pipeline in Jenkins(Recipe Lab) 

 

Step 1 Create a New Item 

Create a new item 



 

 

 

Step 2: Type in Script 

Type in the following script 

node { 

     

    stage ('Build') 



    { 

        echo "Build phase done..." 

    } 

    stage ('Test') 

    { 

        echo "Test phase done..." 

    } 

    stage ('Deploy') 

    { 

        echo "Deploy phase done..." 

    } 

} 

 Click Save 

Step 3: Build Now 

 

Step 4: View Stages 

Then click on stages and you will see everything went well: 



 

 

If you wish the following link will show you additional things you can do in a basic pipeline 

https://www.jenkins.io/doc/pipeline/tour/hello-world/  

 

 

Lab 3 - Get WebGoat 

Estimated time 10 minutes 

This may already be downloaded on the VM. If not, then the instructions on where and how to 

download it are given in this lab. 

Step 1: Navigate to URL 

https://owasp.org/www-project-webgoat/ 

 

https://www.jenkins.io/doc/pipeline/tour/hello-world/
https://owasp.org/www-project-webgoat/


 

 

 

 



 

 

 



You will be using WebGoat as your sample project for many labs. 

Lab 4 - Eclipse  Initial Setup (Recipe Lab) 

Note: This may already be on your VM However, if not, the steps for downloading and 

installing are given in this lab. 

Step 1: Navigate to 

Navigate to https://eclipseide.org/  

 

 

Step 2:Download Eclipse 

Click on the ‘Download 2025-03’  

Then select Eclipse IDE for Enterprise Java and Web Developers 



 

 

 

Step 3: Unzip and Install 

After it is downloaded unzip and begin installing. 



 

When you unzip you will see this: 

 

No open the eclipse folder and double click eclipse.exe 

 



 

Lab 5 –Visual Studio Community Initial Setup (Recipe Lab) 

Note: This may already be on your VM, however, if not the steps for downloading and 

installing are given. 

 

Step 1: Navigate to URL and download 

Navigate to https://visualstudio.microsoft.com/vs/community/ 

And click on download 

https://visualstudio.microsoft.com/vs/community/


 

 

Step 2:Install 

Begin installing  

 



It should not take long, then go to step 3. 

 

Step 3:Launch 

Launch to make sure it installed 

 

 

If you see the next screen you are good to go and can exit for now. 

 



Lab 6 VS Code Initial Setup  

 

Lab7– Jira Initial Setup (Recipe Lab) 

Estimated time: 10 minutes 

Step 1: Navigate to URL 

https://www.atlassian.com/software/jira 

Sign up for the free account.   

 

Lab 8: Synch Jenkins with Jira (Recipe Lab) 

Step 1: Navigate to URL and login 

Login to Atlassian .atlassian.com 

 

Step 2: Go to New Apps 

On the top menu bar select Apps > Find new apps: 



 



 

It will install in just a few minutes 

 

Now we have to go to Jenkins to finish 

Step 3: Navigate to Jenkins 

Login to Jenkins http://localhost:8080. Now go to manage Jenkins 

http://localhost:8080/


 

And choose plugins: 

 

 

Step 4: Install Jira Integration 

Search for jira integration and check the ‘Install’ checkbox 

Click ‘Download now and install after restart’ 

Check ‘Restart Jenkins when installation is complete and no jobs are running’ to restart Jenkins. 

Step 5: View Jira  

Now we are back to Jira. Click the Gear and find apps 



 

Select Jenkins Integration 



 

 

You will actually see multiple apps for Jenkins, choose this one 

 

You then select your site 



 

 

The plugin will then be installed: 

 

After a minute or two you will be notified that it is installed and you should select ‘Get Started’ 

 

Lab 9 Building an App in Jenkins (experiment lab) 

This one will vary from user to user 



https://www.jenkins.io/doc/tutorials/ 

You pick one of the following based on your programming skills and interest: 

 

Only do 1. But when you click you will get step by step instructions. 

Lab 10: Integrate Visual Studio Code with Jira (Recipe Lab) 

Step 1: Get Jira in VS Code 

Inside VS Code type ctrl-shift-p to get the command window and type in Jira 

 

 

Select add Jira site 

Choose login to Jira Cloud 

 

You will be prompted to accept 

https://www.jenkins.io/doc/tutorials/


 

 

Lab 11: Test WebGoat in VS Code 

Step 1: Open Web Goat 

Choose open folder  



 

And navigate to WebGoat 

 

Step 2: Run Basic Tests 

Click on the flask icon 

 

Click on run tests 

 



You can also right click on sections and run individual tests 

 

 

Take time to run a few tests. 

Lab 12: OWASP ZAP 

Download OWASP ZAP and scan some small website. You can scan www.ChuckEasttom.com if 

you wish. The software is in your class materials but also can be found at 

https://www.zaproxy.org/download/  

 

Lab 13: Testing in Visual Studio 

Use Visual Studio (not VS Code) to open web goat 

Analyze ->Run Code Analysis on Solution 

Analyze -> Calculate Code Metrics 

 

 

Bit Bucket Labs 

Lab 14 – BitBucket Initial Setup (Recipe Lab) 

Estimated Time: 20 minutes 

http://www.chuckeasttom.com/
https://www.zaproxy.org/download/


We will be integrating various tools with BitBucket. So, our first goal is to setup a free account.   

Step 1: Navigate to URL 

Navigate to https://bitbucket.org/ 

Step 2: Get the Free version 

Click on ‘Get It Free’ in the upper right hand corner: 

 

Step 3:Create an account 

Then select Create an Account 

https://bitbucket.org/


 

Step 4: Create a workspace 

Create a workspace 



 

Step 5:Create a repository 

 Then create a repository 

 



 

 



 

 

Lab 15: Synch Jenkins and BitBucket  (Recipe Lab) 

Step 1: Go to Plugins 

1. In Jenkins, go to Jenkins > Manage Jenkins > Manage Plugins. 

2. Select the Available tab. 

3. Search for BitBucket Server Integration. 

4. Tick the checkbox. 

You will need to reboot Jenkins after the installation 

Step 2: Visit Jenkins - System 

Now navigate to Manage Jenkins > System 



 

 

 

Now you will scroll down until you see BitBucket integration. If you don’t see it you need to go 

back to the main Jenkins page and update Jenkins. 

 

Step 3: 

The download of the app could take a long time.  Then you can get the remaining instructions 

here: 

https://plugins.jenkins.io/atlassian-bitbucket-server-integration/ 

 

 

Lab 16 – Setup Project in Bit Bucket and integrate with Eclipse (Recipe Lab) 

 

Step 1: Navigate to URL 

Navigate to https://bitbucket.org/ 

Step 2: Create a Repository 

Create a repository: 

https://plugins.jenkins.io/atlassian-bitbucket-server-integration/
https://bitbucket.org/


 

 

Make sure to select ‘With Readme..’ 

 



 

Step 3: View Project 

You should see something like this: 



 

Step 4: Open Eclipse 

Minimize Bit Bucket and open Eclipse 

Note: Windows defender notices are common with Eclipse. Don’t be concerned. 

Step 5: 

Go to file-> Open Projects from the file system 

 

 

Navigate to wherever you put WebGoat in lab 5 



 

 

Now click finish, and you should see this: 



 

Step 5: Share Project 

Now right click on the project, choose teams and share project 



 

 

 

Step 6: Configure Git repository 

Now choose 

Use or create repository in parent folder of project and click create repository then click finish. 



 

 

Step 7: Commit 

Now right click on project, choose team and commit 

 



 

 

You will now see something new at the bottom: 



 

 

You will fist click on the double + signs 

Then in the commit message type ‘first commit and hit the commit button 

 



 

Step 8: Push 

Now right click on the project, choose team > remote > push 

 



 

 

You should see the following screen: 

 



 

Step 9: View code in BitBucket 

Now we will leave that open, go back to your browser and BitBucket to get the information for 

the remote repository. 

In  BitBucket we will be in the source code that we created and now we will click on the clone 

button 

 

Copy that path and past it in a text editor 



 

You can now close that window and click on the settings icon and choose personal bitbucket 

settings 

 



 

On the left you will see App passwords 



 

Click on app passwords then click create app password. You will give this token quite a bit of 

privileges and give it a name, shown here: 



 

Now click create 

You will get a long password that you should copy to the same text file you put the URL in. 

Step 10: Return to Eclipse 

Now it is back to Eclipse to put in this information 



 

When you click next, you will be prompted for the password you copied to the text file 

 

 



Now you type refs/heads/master in three location shown here: 

 

 

Next click Add Spec 

Now check the force update and click next 

 



 

You may be prompted for the password again.  Now just highlight master->master 

 



 

And click finish. 

Now it is back to BitBucket. Make sure you select ‘master’ as the branch 



 

And you will see your code 



 

 

You have now synched your local project in Eclipse with the Project in BitBucket. 

Lab 17: Integrate Bitbucket with VS Code 

Step 1: Get Bitbucket in VS Code 

In VS Code type ctrl-shift-p to get the command window, then type in bitbucket 

 

Choose Focus on Bitbucket pull requests view 

You will then see this screen 



 

 

Step 2: Connect to Bitbucket 

Click on the Connect Bitbucket to view… 

 

Click on Login to Bitbucket Cloud 

You will be asked to confirm access: 



 

 

 

GitHub Labs 

Lab 18 – GitHub Initial Setup (Recipe Lab) 

Estimated time 10 minutes 

Step 1:Navigate to URL 

https://github.com/ 

https://github.com/


 

 

 

Lab 19: Integrate Visual Studio Code with Github (Recipe Lab) 

Step 1 Setup Project 

If Visual Studio code is not already installed, check to see if the installation file is there. If not 

you can download from https://code.visualstudio.com/download 

 

Step 2: Install the GitHub extensions 

 

https://code.visualstudio.com/download


 

 

Note you can add a number of extensions by searching for them: 

 



Step 3 Connect to Github 

Press F1 to open the command window and enter Remote Repositories: Open Remote 

Repository. 

 

Then select open repository from Github 

 

You will be asked to sign in to GitHub 

 

If you click allow, you will be taken to github and asked to authorize Visual Studio Code 

If you wish to go further beyond this lab, 

https://code.visualstudio.com/docs/sourcecontrol/github 

 

https://code.visualstudio.com/docs/sourcecontrol/github


 

Now press Ctrl-Shift-P to get the command palette 

 

Now you will go to View > Source Control 



 

 

You should see the following screen. If you don’t that means you have a folder open and need to 

close it. 



 

Click ‘Clone Repository’ and then type in the URL for your GitHub repository 

 

You will be prompted to provide a destination for the clone 

 



 

You have now linked that repository to your Visual Studio Code 

Lab 20: Viewing Activities in GitHub 

Step 1: Login into a GitHub repository 

You will login to a repository you created in a previous lab. 

 

Step 2: Check Status 

First click on pull requests 



 

From here you can see all pull requests on this particular repository. 

 

Step 3: Setup Security 

Click on security 

 

Choose code scanning alerts 



 

You will see several tools 

 

At least setup the default CodeQL analysis.  If you feel a bit more adventurous, try the 

Advanced, or even the ‘other tools’ 



 

 

Even with default you can edit things like schedule  

 



It will take a few minutes to setup 

Once it is setup you can view activity, including scanning logs 

 

 

Lab 21: GitHub Collaboration 

This will require you to work with at least one other student. 

Step 1: Invite Collaborator 

The host will go to one of their repositories and click on settings 

 

Then select collaborators 



 

 

Then select add people 

 

You will use an email or user name that your fellow student provides you. It must be one they 

have a GitHub account with 

 

Note: while one of my accounts is shown this is just an example. Please do not invite me. 



Step 2: Accept the invitation 

Your colleague will now login into their GitHub. They also probably will receive an email like 

this: 

 

 

That person will then see this 



 

They then accept the invitation and now both of you have access to this Github repository. 

 

GitLab Labs 

Lab 22 GitLab New project 

Step 1: Start New GitLab project 

 Log into GitLab and choose to create a new project: 



 

 

Select Create From Template 

 

Step 2: Use Sample Template 

Scroll down past numerous templates and select Sample GitLab Project 

 



And create a project from this template: 

 

You will see this progress screen: 

 

 

Step 3: Review results 

When it is done you will have this screen: 



 

Lab 23: Create a Pipeline in GitLab 

Step 1: Setup YAML file 

First open a project, then on the left choose Code > Repository 

 

Look for the CI YAML file 



 

 

If you don’t have one, add one 

 

Step 2: Setup Pipeline in YAML 

Paste the following code (note this comes from a GitLab tutorial 

https://docs.gitlab.com/ci/quick_start/#create-a-gitlab-ciyml-file) 

build-job: 

  stage: build 

  script: 

    - echo "Hello, $GITLAB_USER_LOGIN!" 

 

test-job1: 

  stage: test 

  script: 



    - echo "This job tests something" 

 

test-job2: 

  stage: test 

  script: 

    - echo "This job tests something, but takes more time than test-job1." 

    - echo "After the echo commands complete, it runs the sleep command for 20 seconds" 

    - echo "which simulates a test that runs 20 seconds longer than test-job1" 

    - sleep 20 

 

deploy-prod: 

  stage: deploy 

  script: 

    - echo "This job deploys something from the $CI_COMMIT_BRANCH branch." 

  environment: production 

 

Select Commit changes 

Step 3: See your pipeline running 

Go to Build > Pipelines. A pipeline with three stages should be displayed: 

 

 

The project may fail the first time. That is often a problem with copying and pasting the code 

above in step 2. 



Lab 24: GitLab Secure Scanning 

Open your project you created in lab 22 and choose security from the left hand menu: 

 

 

 

 

Lab 25 Experiment With GitLab 

Step 1 Setup Project in GitLab 

You may have already setup a project in a previous lab. 

Projects> New Project use template 

 

Choose Sample GitLab project 



 

 

 

It will take a while to import 

 

 

 

 

When it is done, upload a few code files. It really does not matter what they are, you can use 

WebGoat files if you wish. Or you can push them from Eclipse or Visual Studio if you prefer. 

Now your repository should show a commit for each file you uploaded. 

Step 2: Setup CI/CD 

From the project screen on the right side choose Set up CI/CD 



 

 

This will create a basic script 

 

Step 3: Security Configuration 

Open Security Configuration 



 

Click configure SAST 

 

 

Take a few moments to review the various settings in SAST 

 

 

Online Labs (No VM needed) 

Lab 26: HackMe Pipeline Lab 

https://tryhackme.com/room/introtopipelineautomation 

 

 



Lab 27: Hackme DevSecOps Setup  (Recipe Lab) 

Navigate to  

https://tryhackme.com/path/outline/devsecops 

When you sign up note a) it is free and b) you can skip giving them email and phone number 

You will be taken to the welcome page after you sign up. Then choose ‘Check out our learning 

map’ and scroll down until you see this: 

 

 

Choose DevSecOps 

There are Seven tasks to perform 

 

 

https://tryhackme.com/path/outline/devsecops


Your goal in this first lab is to first get a free account, second navigate to DevSecOps and third to 

just to task 1 and 2. 

 

Lab 28: Hackme DevSecOps Setup  (Recipe Lab) 

Now you return to HackmeDevSecOps  https://tryhackme.com/path/outline/devsecops 

Again navigate until you get to the steps to perform and now finish the remaining five steps: 

 

Lab 29: Git(Recipe Lab) 

Go to https://labex.io 

Choose Git 

https://tryhackme.com/path/outline/devsecops
https://labex.io/


 

You will then select Quick Start with Git. 

 

Click the ‘Start Learning’ button on the far right and you will launch a VM 

 

Simply follow the instructions 

For most labs on this site, there is a point where you will get to labs only available for premium 

(i.e. paid) subscriptions. Always stop there. 



 

 

Lab 30: Docker (Recipe Lab) 

Go to https://labex.io 

 

 

Navigate down to the ‘Docker’ project. 

 

 

 

That will take you to this 

 

 

https://labex.io/


A VM will launch with instructions on the right: 

 

 

Now you will walk through the lab instructions it gives. This is the first 

 

For most labs on this site, there is a point where you will get to labs only available for premium 

(i.e. paid) subscriptions. Always stop there. 

 

Lab 31: Kubernetes (Recipe Lab) 

Go to https://labex.io 

Navigate to Kubernetes 

https://labex.io/


 

 

Start that project 

Just like the dockers lab there is a VM and step by step instructions 

Like before there are instructions for you to follow: 

 

 

 

Lab 32: Another Kubernetes Lab (recipe/experiment) 

This site charges for online labs, but they also have free trials.  You will go to 

https://kodekloud.com/courses/kubernetes-challenges/ 

And select ‘Try the Free Kubernetes Lab’ 

https://kodekloud.com/courses/kubernetes-challenges/


 

 

On the right hand side is a terminal window for you to enter commands. On the left is a menu: 



 

The lab is done by answering the questions. Note the ‘hint’ and ‘solution’ tabs. If you don’t know 

the answer it is given to you! 

Lab 33: HackMe  Kubernetes 

https://tryhackme.com/room/k8sruntimesecurity 

 

 

Lab 34: HackMe Intro to IaC 

 

https://tryhackme.com/room/introtoiac 

https://tryhackme.com/room/k8sruntimesecurity
https://tryhackme.com/room/introtoiac


 

 

Lab 35:Terraform Online Lab (recipe/experiment) 

This site sells access to labs, but you will use the ‘try it for free’ 

https://kodekloud.com/courses/terraform-for-beginners/ 

 

Once in there is a terminal window on the right and questions on the left you will answer: 

https://kodekloud.com/courses/terraform-for-beginners/


 

 

Notice the tab that says ‘hint’ 

Lab 36: Online OWAS ZAP 

There is a limited online version  of OWASP ZAP https://hostedscan.com/owasp-vulnerability-

scan 

 

Results look like this 

https://hostedscan.com/owasp-vulnerability-scan
https://hostedscan.com/owasp-vulnerability-scan


 

 


